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1 Introduction

Thank you for purchasing Business Card Studio from Summitsoft Corporation! Business Card Studio
gives you the power to create business cards, letterhead and envelopes that carry your professional
visual identity. Its flexible tools and effects let you create the right impact for your image, symbol,
trademark, icon, and the like. 

Enjoy the experience of designing business cards like you always wanted to - from creating a look to
printing the finished product. Feel elevated with the perfect creative tool to design a look to represent
any small business or organization and make yourself and your message stand out. Choose from a
range of designs and concepts to create out-of-the-box business card designs to promote your sports
teams, festivals, organizations, fundraisers, conventions, fraternal organizations, educational
institutions, television or radio media, newspapers and publications, music events or artists - just fire
up your imagination and go to work! 

Business Card Studio gives you a range of exciting features and

options to work with: 

Import logos from our own best-selling Logo Design Studio, as well as other graphics and image
formats, or directly from your scanner or digital camera.

Customize your business card design with our pre-designed templates.

Choose from a selection of objects, shapes, and taglines custom-made for almost any concept.

Save time with intuitive options and easily accessible tools, templates, designs, and objects.

Export your image to an output format that works with the program of your choice.

Design matching letterhead and envelopes to create a consistent look between your business card
and stationery.

Business Card Studio works for both design professionals and novice users alike, with nearly limitless
choices and an interface that simplifies your design process, making it easier for you to concentrate
on the overall look of your card.

PLEASE NOTE: Any references to company names and persons in sample templates and
screenshots are for demonstration purposes only and are not intended to refer to any actual
organization. Screenshots are only meant to represent the program interface and may not accurately
show included templates and objects.

1.1 What Is Business Card Studio?

Summitsoft's Business Card Studio, features intuitive options with a superior look and feel. It uses the

new tabbed toolbar interface used by Microsoft®, and offers many of the same enhanced feature
options found in our best-selling Logo Design Studio that give you a more powerful and easy-to-use
design environment.  

Discover these Business Card Studio features:
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A selection of templates and objects to choose from with single-click insert option. Business Card Studio's
tabbed toolbar interface features intuitive tabs and buttons that offer easy access to advanced tools.

Object, shape, and text options are organized efficiently under the menus for effortless navigation. 

My Projects folder is listed under the File menu for easy accessibility and to manage multiple projects from
a single window. 

Smart Interface with inherent slide-out panes featuring the most commonly used options for editing your
design objects. 

Exciting? How about sending your business card design to your friend as an email with just a single click?
You can also print your card not only directly on cardstock, but also in a  PDF document or in an image format
ready to place in a document. 

Want more? Export your business card in an Internet-optimized format that looks great on a computer screen
yet takes less disk space. You can even export your card in greyscale format - perfect for faxing or other
specific purposes.

Discover more options with Business Card Studio. Unleash the power of your imagination and have fun
doing it. 

1.2 Registering Business Card Studio

Registering your Business Card Studio software is important. Registration provides you with timely
access to the latest product updates, technical support, valuable information about new product
releases, access to free downloads and business card templates, articles, tips and hints, and special
offers on other Summitsoft® products.

To register your version, click the Help button on the main toolbar and click on Register Product
Online. 

You can also register online at:

http://www.summitsoftcorp.com/windows-software/register/register.html

http://www.summitsoftcorp.com/windows-software/register/register.html
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2 Getting Started

Find out more on how to start using Business Card Studio. Follow the steps outlined in the following
topics to install and use your software.

 

What would you like to learn more about? 
 

Installing Business Card Studio 

Creating Your First Business Card

About the Interface

2.1 Installing Business Card Studio

Insert the Business Card Studio CD-ROM into your CD-ROM drive. Once the auto-run appears on
your screen, click Install to launch the installation program. You will be asked to read and accept our
End User License Agreement prior to installing the program. Click Accept only after you have read and
understood these terms, and then follow the on-screen installation instructions in order to complete the
installation. 

If you have Auto-Run disabled, Click on Start | Run, and type in D:\Autorun.exe  (where “D” represents
the letter of your CD-ROM drive).

2.2 System Requirements

To install and use Business Card Studio, we recommend that your computer meets the following
minimum system requirements: 

Hardware: PC with Pentium 233 MHz or higher processor.

Operating System: Microsoft Windows® XP, Microsoft Windows® Vista, Microsoft Windows® 7.

Memory: 512 MB of RAM.

Hard Disk: 700 MB of available hard-disk space.

CD-ROM or DVD-ROM drive (for boxed shipments).
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2.3 How to Use This Help File

To learn more about Business Card Studio, click on any of the help file topics in the list of topics at the

left. Click on any of the book (  ) icons to see the topics listed below it; click on any of the page (

 ) icons to display in this window the topic associated with that page. You can also move through
the topics collected in any given book by clicking the Previous and Next buttons in the upper right.

How to access Help topics
Click the Help button on the main toolbar at the top of the Business Card Studio interface to access
the help topics. You can also press the F1 key on your keyboard to display the help topics. 

2.4 Quick Tips

Business Card Studio offers over 10,000 unique card designs to help create and print your business
card quickly. Simply pick a template to open it in the software and then change the text to your own;
you can move the text around and edit it in any way to better match the look you want.

Business Card Studio is also unique in that the software will actually create an unlimited number of
new card concepts for you rather than only relying on the included pre-designed templates. With the
right combination of fonts, graphics, backgrounds, shapes, colors and more, you can easily create
millions of unique variations that are unique to your own choices and design style.

To get you started quickly, there are a number of tips to follow that can guide you on finding
that right look:

Using the Design Assist™ wizard, the number of cards generated are based on how many variables
you add to the wizard; like number of fonts, number of colors, backgrounds, objects, etc.

The amount of cards generated are also limited by hard drive space and memory.  Business Card
Studio constantly runs in optimized mode, but if you are generating thousands of cards, the program
may crash on older systems.  If this occurs, simply reboot the computer to clear any memory cache
and restart the program with fewer options.

Each time you exit Business Card Studio after running the Design Assist wizard, the generated
cards are cleared (not saved). To save card concepts you like, simply add them to "My Cards."

After using the Design Assist wizard to generate new concepts, make sure to make any fine
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adjustments to a card you want to print or get printed. You should never fully rely on anyone but
yourself in determining if the look of your card is exactly the way you want it. 

If you are printing your cards commercially (like FedEx Kinkos®, or other places), these printers will
generally except a high-resolution TIFF or BMP (up to 1200 DPI). Just go through the export process
and send the exported image to your printer and they will lay it out on their template for you. The
PDF format is also an option most commercial printers accept.

Not sure where to start? Choose the New Card button in the main program Home tab to open the
"Create a New Card" window. You can then quickly choose a pre-designed template or select the 
Generate Cards button to begin the Design Assist wizard.

If you don't have a logo for your business card, browse through the Objects categories to find a pre-
designed logo graphic you can easily add to your card.

Need to change some text on your business card? Simply select the text on the canvas and it
should appear in a "Selected Text" box in the Advanced Tools panel on the right side of the program
window. Type in some new text and click the Replace button to change the canvas text.

If you plan on printing your business card yourself, simply click the Print button in the main program
Home tab to open your card in the Print Options window. You can choose from popular Avery card
stock or adjust to a custom size. When you are ready, click the Print button.

Before you print your business cards on a sheet of business card paper, try printing on a regular
sheet of paper. This way you can see if there are any potential sizing problems before wasting a
sheet of your special card paper.

If you are having a professional printer print business cards for you, they will most likely be able to
use either an exported TIFF image of your card, or a card in PDF format.

If you want to move all text and graphics on the canvas at once, simply go to the Home tab and click
the Select All button. Now you can just drag everything around your canvas using your mouse.

You can adjust the height and width of your business card canvas by going to the Canvas tab
section and clicking on the green Card Canvas arrow.

Confused on where to find your saved project? By default, Business Card Studio saves your files in a
My Business Card Studio Projects folder in My Documents ("Documents" for Windows Vista or
Windows 7 users), but you can also save these files anywhere you choose.

Some users mistakenly try to open and use the thumbnail that is generated when they save their
business card (Save or Save As... instead of Export). Make sure you know where you are exporting
your business card to so you don't get mixed up.

After placing an object or text on the business card canvas, you can use your keyboard arrow keys
to nudge the object or text in the direction of the arrows.

To add text to your business card, simply go to the Insert tab section, enter the text you want in the
white Text field, choose a text style (Simple, etc.) and then click the Add New Text button. Your
mouse cursor will now be crosshairs when you move it over the canvas; just click anywhere on the
canvas to place your text there.
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3 Creating Your First Business Card

Working with the extensive features of Business Card Studio is easy, once you familiarize yourself
with the user interface and the toolbars.

When you launch Business Card Studio, a welcome window will open, giving you the options to
create a new card. letterhead or envelope from a blank canvas; generate cards from a pre-designed
template; generate cards with the Business Card Studio built-in Design Assist wizard, or open a
recent project file that you may have previously saved. (You may also display this welcome window by
selecting New Card from the Home menu.)
 

Learn More About:

Using a Blank Canvas

Using a Pre-Designed Template

Using the Design Assist Wizard to Generate New Cards

My Projects option
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3.1 Using a Blank Canvas

To create a new business card. letterhead or envelope using a blank canvas, click the large Blank
Canvas button in the Create a New Card section at the top of the welcome window. This will give you
three options (Blank Card, Blank Letterhead, Blank Envelope) which will then open a new blank canvas
in the Business Card Studio main program window based on what you select.

Opening a Blank Card canvas
When Business Card Studio first opens your blank canvas (as selected from the welcome window),
the canvas window opens a default canvas that is 3.5 inches in width by 2 inches in height. To resize
the canvas, go to Canvas in the Menubar and select Resize to display the Canvas Setup section of
the Preferences panel. You can resize the canvas dimensions in pixels, inches, centimeters (cm), or
millimeters (mm); adjust the resolution (300 dpi is recommended for print use, 72 dpi for web use);
change the background, and add a grid for more accurate text and object placement.

You can also create a card from a blank canvas by selecting New from the File menu (the large round
button at the top left of the main program window displaying a large "C" holding a business card). If you
have a business card project currently displayed, you will be prompted to save any changes you made
to it before your new project is opened. The New Project dialog window will now appear: 

Enter the name for your new card project in the Project Name field. This name will be the name of the
project folder Business Card Studio creates for you. This location will be in a sub-folder of your My
Documents folder called My Business Card Studio Projects. The  Default Location checkbox is
checked by default; uncheck it if you want to save the card in a different location and either edit the
pathname in the Location: field or click Browse to navigate to a new location. You can set the canvas
dimensions based on pixels, inches, centimeters (cm), or millimeters (mm); adjust the resolution (300
dpi is recommended for print use, 72 dpi for web use); and change the background. Click Ok to create
the canvas.

Opening a Blank Letterhead canvas
When Business Card Studio first opens your blank canvas (as selected from the welcome window),
the canvas window opens a default canvas that is 8.5 inches in width by 11 inches in height. To resize
the canvas, go to Canvas in the Menubar and select Resize to display the Canvas Setup section of
the Preferences panel. You can resize the canvas dimensions in pixels, inches, centimeters (cm), or
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millimeters (mm); adjust the resolution (300 dpi is recommended for print use, 72 dpi for web use);
change the background, and add a grid for more accurate text and object placement.

You can then design your own look for your letterhead and save the letterhead as a new template to be
used when matching your letterhead to your business card at a later time. To do this, first design your
own letterhead.

When you are done designing, choose the Letterhead & Envelope menu option.
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To save the letterhead as a new template, click the "Letterhead Save As..." button in the Matching
Sets group box. This will open the Letterhead window, allowing you to match the text and graphics on
your letterhead to their respective fields in the Letterhead window.
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To match your letterhead information with the fields in the window, make your selections from each
dropdown box in the window. Click the Cancel button at any time to close the Letterhead window
without saving, otherwise click the Save button when you are ready to save the letterhead as a future
template. The Save dialog will open.
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Enter a Letterhead Name you will remember easily and do not change the Location or the template will
not appear when you try and use the saved template later in Business Card Studio.

Click the Ok button to save the template. New letterhead or envelope templates are saved in My
Documents ("Documents" for Vista or Windows 7 users), in a folder called "My Business Card Studio
Templates". To use the new letterhead template with a business card you created, follow the steps
outlined in the Letterhead & Envelope section of this help guide.

Opening a Blank Envelope canvas
When Business Card Studio first opens your blank canvas (as selected from the welcome window),
the canvas window opens a default canvas that is 9.5 inches in width by 4.125 inches in height
(standard #10 size US envelope). To resize the canvas, go to Canvas in the Menubar and select
Resize to display the Canvas Setup section of the Preferences panel. You can resize the canvas
dimensions in pixels, inches, centimeters (cm), or millimeters (mm); adjust the resolution (300 dpi is
recommended for print use, 72 dpi for web use); change the background, and add a grid for more
accurate text and object placement.

To create a new envelope template that can be used to match with your business card(s), follow the
steps shown above in the Opening a Blank Letterhead canvas topic, substituting "letterhead" with
"envelope".

3.2 Using a Template

Business Card Studio gives you over 10,000 unique horizontal and vertical card designs to get you
started. Once you open a template you will need to change the text to your own information and make
any other adjustments to get the card looking exactly like you want.

Once you select and open a business card template from a category in the welcome window, the
selected card template will open in the Business Card Studio main program window.
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Once the card template appears in the canvas window, you can click on any element to modify or
delete it. Different options become available on the Advanced Tools slide-out pane to the right once you
click on an element in the canvas (just click the Advanced Tools side tab to slide out the pane),
depending on whether it is text, a shape, or a graphic object. Read the appropriate sections of this
help to learn more about graphics, text, shapes, and taglines, as well as saving and using your
business card.

To modify a pre-designed business card template to your own look, simply select a template category
from the left and then double click-on the desired card template in the Templates View section. You
can also select a business card template and then click the Open button at the bottom of the window
to open that template.

3.3 Using the Generate Cards Wizard

To create a business card using the Business Card Studio built-in Design Assist wizard, click the
large Generate Cards button at the top. This will display the first of a series of screens for you to enter
the information necessary to create your business card.

Entering Your Company Information
On the first screen, the Logo and Company Name Details screen, select whether or not your company
logo includes your business name. If it does not, enter your company name in the Company Name
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field below the My Logo does not contain my business name option. If you do not have or plan to
use a logo on your card, select the I do not have a Logo option. Click Next to proceed to the next
screen.

Enter your name, business title, address, and contact information in the fields provided on the
Personal and Contact Information screen and check or uncheck the Include boxes beside the
information fields you want to include or exclude from the display. (By default, the Include check
boxes beside the Name field, address fields, Email Address, Website Address, and
PhoneNumber1 fields are checked for you.) Click Next to proceed to the next screen.

If you have a logo you wish to include, you can specify up to three logos on the Choose Logos screen
to include on your card. If you have created logos with Logo Design Studio, you can search for them by
checking the Find all Logo Design Studio logos check box. Otherwise, you can specify logos by
entering their pathnames in the fields beneath the check box or use the Browse buttons to the right of
those fields to navigate to those logos.

You can add separator lines to the card by checking Include Lines in card generation and a
shadow effect to the text by checking Randomize shadow effect. Click Next to proceed to the next
screen.

Although Business Card Studio lets you include up to three logos, in most cases you are better off
using only one logo on your card to avoid making it look too busy. You can, however, use a second
image as a background image with this option.

Defining Your Layout
Choose either Backgrounds or Textures from the dropdown list on the Choose Other Elements
screen and then check the box for the subcategory you wish to include. Click on an image to
incorporate it in your card. Click Next to proceed to the next screen.

Choose Horizontal Card or Vertical Card on the Card Alignment screen to specify your card's layout
and then choose one of the options to indicate how you wish to align the elements of your card with
respect to each other. The alignment option will appear as a yellow box or boxes on the alignment grid.
Click Next to proceed to the next screen.

Choose the colors you wish to use for your card's text on the Font Color Randomization Options
screen. Check Use one color per card if you want to have all text appear in the same color. (This
option is best if you plan to print your card in black and white or grayscale.) If not, you can use one of
the color randomization options for your company name, address block (physical address), or contact
information (phone, email, and Web).

You can select colors to choose from by moving your cursor over the color spectrum, where it will
change to an eyedropper, and clicking to display the color and its hexadecimal code in the boxes
above the spectrum. (You may also input the hexadecimal code to display the corresponding color in
the color box.) 

Click Add to add the color to the color swatches at right; you may add up to 24 colors. To drop a color
from the swatch group; select it and click Remove. Click Default Colors to reduce the available
colors to only black and white. Click Next to proceed to the next screen.

Choose the font styles you wish to use for your card's text on the Font Style Randomization Options
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screen. Check Use one font per card if you want to have all text appear in the same font. If not, you
can use one of the font randomization options for your company name, address block (physical
address), or contact information (phone, email, and Web).

You can select a font from the System Fonts graphical display list by highlighting it and clicking Add
to add it to the Fonts to Use list. To remove a font from the Fonts to Use list, highlight it and click
Remove. Click Next to proceed to the next screen.

Do not try to add all your fonts, as you might see unexpected font combinations on your card. In
general, it is best not to mix serif and sans-serif fonts, although using one kind of font for your
company name and the other kind for your address and contact information may make it stand out
better, depending on the fonts you select. To begin, try just selecting 2-3 different font styles and see
how these can affect the look and layout of each new generated card.

On the Background Color Options screen, choose Use image for background if you are using a
background image, or Use color for background if you plan to use a solid color background, and
choose the color you wish to use for your card's background on the Background Color Options screen
by either moving your cursor over the color spectrum and clicking to select the color or entering its
hexadecimal code in the field above the spectrum.

Click Add to add the color to the color swatches at right; you may add a number of colors; we
recommend making sure black and white are two colors that are always selected. To drop a color from
the swatch group; select it and click Remove. Click Default Colors to reduce the available colors to
only black and white. Click Next to proceed to the next screen.

Click Finish to generate your card, which will appear on the card canvas, with a thumbnail image in
the Generated Ideas window. If you are not satisfied with the results, right-click the thumbnail and
select Edit Card to modify the text, objects, or shapes using the options on the menubar or slide-out
panes.

When you have the card as you wish, right-click either its Generated Ideas thumbnail or its canvas
image and click Add to My Cards to add it to the My Cards window.

3.4 My Projects

If you have already saved a project file in Business Card Studio, you can reopen it again and work on
it further. Click the large My Projects button at the top of the welcome window to view your available
project files. To open one, simply double-click on the file to open it in the main program window.
Please note that any matching letterhead and/or envelope you add to a business card project file will
be saved in the card file (letterheads and envelopes are not saved as individual files).
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Business Card Studio creates a file for your business card project in your project folder with the
extension .bcg. This file can only be opened within the program and allows you to modify your
business card file at any time. Do not move a file with the .bcg extension out of the project folder;
otherwise, it will no longer show up in your recent project files. The .bcg file also includes any
matching letterhead and/or envelope you add to your business card.

Once you set up your canvas, you can then add graphics, text, shapes, and taglines. Read the
appropriate sections of this help file to learn the details of adding and modifying these elements, as
well as saving and using your card. At any time, you can choose to open a logo template by selecting 
New from the File menu and choosing a template from one of the categories in the welcome window.
Different options will become available on the toolbar and in the Advanced Tools slide-out pane to the
right once you add an element to the canvas, depending on whether it is text, a shape, or a graphic
object.
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4 The Interface

The Business Card Studio interface was designed to help you create a business card in as few steps
as possible. 

Main Toolbar Left Slide-Out Pane

Menubar options Canvas

Right Slide-Out Pane Bottom Pane

Clicking the card canvas itself (instead of an object, text, shape, or image on the canvas) will
automatically display menu options that allow you to insert shapes, graphics (Pictures or Objects),
text, a tagline, or a new concept canvas.

Adding a new concept canvas lets you work on different variations of a single card project file. 

You can switch your canvas view between two or more concept canvases in one of two ways. The first
is by clicking the Card Concept & Info tab to the left of the logo canvas. When this slide-out pane
opens, simply select which canvas you want to view by clicking the Concept tab (if its window is not
already displayed) to view the canvases available in the Card Concept window. You can see the canvas
size and related information relating by clicking the Info tab.

The other way is by selecting one of the thumbnails on the My Cards window at the bottom of the
screen, accessed by clicking the My Cards tab.
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4.1 Main Toolbar

The toolbar at the top of your Business Card Studio main window includes a File menu (the round "C-
holding-a-card" button at the top of the Business Card Studio main window) and the Save, Export,
Print, Preview, and Help menu buttons. In addition to these options, many other options are organized
inside the menubar. Click on any menu name (or icon) to display a list of functions and tools.

Learn More About:

Toolbar Options

Menubar Options

Slide-Out Panes

4.1.1 Toolbar Options

The main toolbar at the top of the main Business Card Studio window consists of a large File menu
button in the upper left and smaller menu buttons to its right.

The File Menu
The File Menu contains the options to create, open, save, import, export, revert, print, email, and close
your Business Card Studio projects. You can also set user preferences by clicking the Preferences
button at the bottom of the File menu. Click Exit to exit out of the File menu; click Close to exit out of
Business Card Studio. 
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Other Menu Buttons

The rest of the main toolbar offers quick options to perform the most useful functions. You can save, export,
or print your project from here. You can also click the Preview button to preview the canvas and click the Help
button to access the Help topics from the main toolbar. 

4.2 Menubar

The Menubar is located just below the main toolbar on the Business Card Studio interface. The Home,
Insert, Color,  Effects, Canvas, and Letterhead & Envelope tab menus organize and list the most
commonly used functions. 

In addition to these visible menus, many options and features are also conveniently available in side
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the slide-out panes. These options are usually dependent on the position of the cursor inside the
Business Card Studio interface and based on the item selected inside the canvas.

4.2.1 Home Menu

You can use the Copy, Cut, Paste, Undo, Redo, and Delete buttons in the Home menu tab for any
selected object. 

Copy will create an exact copy of the selected object that you can then Paste in another location on
the business card canvas. Cut removes the selected object from the canvas, but you can then paste it
in another location or on another canvas. If you are unhappy with a change you have made, click Undo
to undo it; then, if you decide you like the change after all, click Redo to restore it. Click the Delete
button to permanently remove your selection from the card canvas.

Click the Clone button to make a copy of the selected object. The copy will appear in a new layer on
top of that of the original object, slightly lower and to the right of the original. The copy will become the
selected object for further duplications and manipulation. To delete the selected object, click the 
Delete button, or press the Delete key on your keyboard. You can also select the items on the canvas
and group and ungroup them by using the Group and Ungroup buttons on the Home menu. 

4.2.2 Insert Menu

The Insert Menu tab on the Menubar contains important functions to insert shapes, graphics, text, and
taglines onto the canvas.

To insert a shape, graphic, text, or tagline, click the appropriate button and click on the canvas, if you
have set your preference to Insert by Click. (If not, click and drag the item to the canvas.) Once you
have placed your desired item on the canvas, the menu switches itself to the format options listed
under the Home menu tab, and you can then slide out the Advanced Tools panel (at the right of the
card canvas) from the right slide-out pane to edit the item. 
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4.2.3 Color Menu

The Color menu tab includes options that let you change the color characteristics of your object,
shape, or text, or fill them with a solid color, gradient, or picture. You can also modify the hue,
saturation, and lightness, brightness and contrast, or pick colors.

Solid
The Solid option on the Color dialog blends the color you select with the pre-colored objects included
in Business Card Studio.

Select your new object color from the Select Color dropdown by clicking the down arrow at the right of
the dropdown. Click the square corresponding to the color you want to apply, or click More Color to
access a palette with additional shades of color.

You can access more sophisticated color palettes by clicking Advanced Color Palettes. To accurately
change the color of pre-colored graphic objects, however, you must instead use the Advanced Hue,
Saturation, and Lightness Controls.

Hue, Saturation, & Lightness
This is the only control that lets you accurately change the color of Business Card Studio's included
Objects, and is the default color option with any selected object. 

Slide the Hue slider to change the color of the selected object. Colors are arranged as a color wheel
starting from red, and going up the spectrum through orange, yellow, green, blue, indigo, and violet
before turning magenta and becoming red again. When the slider is moved all the way to the left or
right, the object will revert to its original color.
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Slide the Saturation slider to change the color saturation. Move the slider to the left to make the color
appear more "washed out"; move the slider to the right to make the color appear more vibrant.

Slide the Lightness slider to change the lightness or darkness of the color. Move the slider to the left
to make the color appear darker; move the slider to the right to make the color appear lighter.

Click Apply when you are satisfied with your changes, or Cancel to restore the object to its original
appearance.

Fill With Picture
You can fill your selected object with an image. To do this, enter the pathname of the graphic location,
or click the Browse Image button. 

A dialog will appear from which you can navigate to the location of the graphic image using one of the
buttons on the left side of the dialog or the Look in: drop-down field at the top of the dialog. 

You can select a specific graphic type using the Files of type dropdown; when the file you want
appears in the main window, click it and then click the Open button to select the graphic.

You can tile the graphic image within the object by checking the Tiled checkbox. When the box is
unchecked, the image appears only once.

Use the H Disp and V Disp sliders to change the placement of the fill image within the object. 

Click Apply when you are satisfied with your changes, or Cancel to restore the object to its original
appearance.

Gradient
You can choose one or two colors to use in the gradient with the Color1 and Color2 dropdowns.
Clicking either dropdown displays a color selection dialog; click the square corresponding to the color
shadow you want to apply, or click Custom to access a palette with additional shades of color. You
can see how the colors appear together in the Gradient sample field above the dropdowns.

You can control the saturation for either color by using the slider beneath the color dropdown. Slide the
slider left to decrease the saturation level or right to increase it.

Select the direction for the colors to change from the Gradient Direction dropdown and the pattern of
color change with the Fill Method dropdown. A sample of the gradient pattern will appear in the
Preview squares to the right of the dropdowns. The pattern will also appear in the selected object on
the card canvas.
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Click Apply when you are satisfied with your changes, or Cancel to restore the object to its original
appearance.

Brightness/Contrast 

You can adjust how sharply an object appears on the canvas by using the Brightness/Contrast
controls.

Slide the Brightness slider to the right to make the image appear brighter or left to make it appear
darker. Slide the Contrast slider to the right to make the image stand out more and left to make the
image less distinct. You can often get the sharpest results by sliding the Brightness slider all the way
to the left and the Contrast slider all the way to the right.

Click Apply when you are satisfied with your changes, or Cancel to restore the object to its original
appearance.

Color Picker
The Color Picker option works best when you have an object with a solid color, not an object with a
glassy or multicolored effect. This option allows you to accurately match any other color you choose.
Just click the Color Picker button and drag the crosshairs to the color you want to pick. (The preview
box to the left of the button shows you what color your object will change to.) 

Once you find the color you want on your computer screen, press your left mouse button to apply that
color to the object. 

4.2.4 Effects Menu

You can add Shadow, Frame, Blur, and Emboss effects to your selected object by clicking the Effects
menu tab, and then choosing the effect you want from the choices you are given by clicking the Effects
button.
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Shadow 

Places a shadow behind your selected object.

 
Use the Opacity slider to adjust the transparency of the selected object. A selected object's opacity
may be adjusted from a default of 100 percent (fully opaque) down to 0 percent (fully transparent) on
the card canvas. When an object is partially transparent, objects and text below it show through. Use
the Shadow Opacity slider to change the opacity of only the shadow.

Use the Blur Radius slider to change how blurred the shadow appears. Move the slider left to make
the shadow sharp, and right to make the shadow blurry.

Select the color for your shadow from the Shadow Color dropdown by clicking the down arrow at the
right of the dropdown. Click the square corresponding to the color shadow you want to apply.

Use the Vertical Position and Horizontal Position sliders to change the displacement of the shadow
from the main image. 

Click Apply when you are satisfied with your changes, or Cancel to restore the object to its original
appearance.

Frame 

Creates a border around your selected object.

Select the color for your frame from the Color dropdown by clicking the down arrow at the right of the
dropdown. Click the square corresponding to the color frame you want to apply.

Use the Width slider to determine the width of the frame. Move the slider left to narrow the frame's
width and right to thicken it.

Use the Spacing slider to determine how far from the object the frame is. Move the slider left to bring
the frame tighter around the object and right to place it further away. Use the Radius slider to control
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how rounded the corners of the frame appear. Move the slider left to lessen the rounding and right to
increase the rounding.

Click Apply when you are satisfied with your changes, or Cancel to restore the object to its original
appearance.

Blur 

Softens your selected object with a default blur effect. 

The Blur effect will completely cover any of Business Card Studio’s included full color objects with
the default blur effect.

Use the Opacity slider to adjust the transparency of the selected object. Select the color for your blur
from the Blur Color dropdown by clicking the down arrow at the right of the dropdown. Click the
square corresponding to the color shadow you want to apply.

Use the Blur Radius slider to change how blurred the object appears. Move the slider left to make the
object appear sharp and right to make the object appear blurrier.

Click Apply when you are satisfied with your changes, or Cancel to restore the object to its original
appearance.

Emboss
Adds a raised effect to your selected object. 

Move the Height slider to the right to give your object a greater embossed effect. You can adjust the
color of the embossed edges by using any of the color options found in the Color menu tab.

Click Apply when you are satisfied with your changes, or Cancel to restore the object to its original
appearance.

4.2.5 Canvas Menu

The Canvas menu tab includes preferences to modify the card canvas, and features the Canvas tool to
change the Canvas Color and Workspace Color. 
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You can resize the canvas, change the canvas background, and rename the canvas from the Canvas
menu. For additional preferences, click the green arrow at the bottom of the Card Canvas section. 

The Panels group box opens a selected panel in the main Business Card Studio window (helpful if you
close a panel by accident). The Reset Workspace option will automatically replace the default panels
(if any are missing) that you originally start with in Business Card Studio.

 

4.2.6 Letterhead & Envelope

The Letterhead & Envelope Menu tab on the Menubar contains important functions to match a
letterhead and/or envelope to your currently opened business card.

Once you have completed the design of your business card and saved it, click the Letterhead &
Envelope Menu tab to view the options.

The two active buttons on the left side of the Matching Sets group box include:

Letterhead - opens a window that allows you to choose a pre-designed letterhead layout and match
the text and graphics on your business card to the text and graphics on the letterhead layout. Any
letterhead templates you create and save on your own (Using a Blank Letterhead) will appear in the
"Choose Letterhead Template" window for you to choose at any time.

Envelope - opens a window that allows you to choose a pre-designed envelope layout and match
the text and graphics on your business card to the text and graphics on the envelope layout. Any
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envelope templates you create and save on your own (Using a Blank Envelope) will appear in the
"Choose Envelope Template" window for you to choose at any time.

The other two inactive buttons ("Letterhead Save As..." and "Envelope Save As...") are only active if
you are creating a Blank Letterhead or Blank Envelope, and want to save your newly created letterhead
or envelope as a template that you can use to match to a business card. 

Letterhead
To create matching letterhead, click the Letterhead button in the Matching Sets group box. This will
open the "Create Matching Letterhead" window. The first step will be to choose a letterhead template
(how the text and graphics will be positioned on the letterhead).

Once you select a template, click the Next button. You can also close this window without creating
any matching letterhead by simply clicking the Cancel button. If you click the Next button, your next
step will be to match the information and graphics on your business card to the fields available on the
selected letterhead template. Please note that not all fields may be present on the template you
selected, but you can manually add these later, after the letterhead has been created.
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To match your business card information with the fields on the template, make your selections from
each dropdown box in the window. For the example above, you would need to match the Company
Name; Address; City, State, Zip; Website; Phone 1; Fax; and Logo. You can also choose whether or
not to include a background from your business card. If you have a background on your business card
and would like to add this to your letterhead template, make sure to check the "Use Background"
checkbox.

When you are done, click the Finish button to create the matching letterhead.

Depending on your logo, graphics or amount of text on the business card you are using to create
matching letterhead, the letterhead may not look perfect. However, you can quickly adjust any text or
graphics manually to fine-tune the look of your letterhead.

Once your letterhead has been created you can save the new letterhead as a new template. Do this by
clicking the "Letterhead Save As..." button in the Matching Sets group box and matching the fields in
the window that opens up. Click the Save button when you are done and your new template will show
up in the "Choose Letterhead Template" window the next time you are creating matching letterhead.

To save your letterhead and business card together as a single project file, click the Save button in the
Quick Access Toolbar, or select the Save option in the File menu.
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Print your letterhead by clicking the Print button. This will open the Print window to preview the print
job and make any last minute adjustments.

Please note: If you notice any margins or borders around your letterhead when printing, this is most
likely because of your printer settings. Please refer to your printer manual or help file to fix this.

Envelopes
To create matching envelopes, click the Envelope button in the Matching Sets group box. You can
then follow the same guidelines as outlined in the Letterhead section, substituting "letterhead" with
"envelope".

Clicking the Envelope button will open the "Create Matching Envelope" window. The first step will be to
choose a envelope template (how the text and graphics will be positioned on the envelope).

Once you select a template, click the Next button. You can also close this window without creating
any matching envelope by simply clicking the Cancel button. If you click the Next button, your next
step will be to match the information and graphics on your business card to the fields available on the
selected envelope template. Please note that not all fields may be present on the template you
selected, but you can manually add these later, after the envelope has been created.

To match your business card information with the fields on the template, make your selections from
each dropdown box in the window. You can also choose whether or not to include a background from
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your business card. If you have a background on your business card and would like to add this to your
envelope template, make sure to check the "Use Background" checkbox.

When you are done, click the Finish button to create the matching envelope.

Depending on your logo, graphics or amount of text on the business card you are using to create
matching envelope, the envelope may not look perfect. However, you can quickly adjust any text or
graphics manually to fine-tune the look of your envelope.

Once your envelope has been created you can save the new envelope as a new template. Do this by
clicking the "Envelope Save As..." button in the Matching Sets group box and matching the fields in
the window that opens up. Click the Save button when you are done and your new template will show
up in the "Choose Envelope Template" window the next time you are creating matching envelope.

To save your envelope and business card together as a single project file, click the Save button in the
Quick Access Toolbar, or select the Save option in the File menu. You can also save your business
card, letterhead and envelope altogether in the same single project file.

Print your envelope by clicking the Print button. This will open the Print window to preview the print job
and make any last minute adjustments.

Please note: If you notice any margins or borders around your envelope when printing, this is most
likely because of your printer settings. Please refer to your printer manual or help file to fix this.

4.3 Slide-Out Panes

The slide-out panes are the most intuitive and convenient option in the Business Card Studio interface.
These context-sensitive panes automatically display the necessary tools based on your selection on
the canvas. You can dock or undock them as you wish. 

Learn More About:

The Left Slide-Out Pane

The Right Slide-Out Pane

The Bottom Pane

4.3.1 Left Slide-Out Pane

The left slide-out pane is located at the left side of the card canvas. The left slide-out pane features a
list of logo designs and taglines, along with the business card concept and more information about the
card project. To slide out the left slide-out pane, simply move your cursor over the tab, hold down your
left mouse button, and drag. 

You can also open the Logo Designs (graphic objects) and Tagline panes by choosing the respective
buttons in either the Insert or Canvas tabs in the ribbon toolbar at the top of the program window.

To dock the pane, click the pushpin icon on the top right corner of the pane. Once the pane is out, you
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can keep it open permanently by clicking the pushpin icon at the top right of the pane.

Learn More About:

Logo Designs Tab

Card Concept & Info Tab

Taglines Tab

4.3.1.1 Logo Designs

The Logo Designs tab on the left slide-out pane lists a variety of objects that you can insert and
customize for your business card design project. These objects are organized efficiently into different
categories. To insert a logo design, choose a category, select the desired design from the list, and
click on the canvas to add the design.
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4.3.1.2 Card Concept & Info

The Card Concept & Info tab on the left slide-out pane displays a two-tabbed page that outlines the
basic information about your design project and displays your business card concept. Click the 
Concept tab to display multiple card projects and switch between them by clicking  the icon for the
corresponding project. Click the Info tab to display basic information about your design project. 
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4.3.1.3 Taglines

 
Business Card Studio gives you unlimited
possibilities for designing business cards that
stand out in every aspect. The Taglines option
gives you a variety of captions custom-made for
almost all concepts and functions. You can
locate this tab on the left slide-out pane. To
insert a tagline, choose the appropriate
category, select the tagline, and then click on
the canvas where it needs to be inserted.
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4.3.2 Right Slide-Out Pane

The right slide-out pane is located at the right side of the card canvas. The right slide-out pane tabs 
Alignment and Layers cover the placement of text, graphics, and objects on the canvas. The right
slide-out pane also displays a selection of advanced tools to edit the objects on the canvas.

Learn More About:

Alignment Tab

Layers Tab

Advanced Tools Tab

4.3.2.1 Alignment

The Alignment tab, located in the right slide-out pane, lets you align your design objects on the card
canvas. If the Alignment tab is not available on the right side, you can open it by going to the Home
menu tab, clicking the Align button, and selecting Advanced Alignment.

The top nine choices will align two or more selected
objects with each other.

You can manipulate the position of any selected object by
using the Advanced Alignment boxes at the bottom of the
Alignment section. Use the Left and Top boxes to
determine how far to place the object from the left and top
edges of the canvas. 

Use the Width and Height boxes to adjust how wide and
how tall the object appears. Either enter the value directly
in the field or use the up and down arrows to the right of
the field to change the field's value.

You can also align your objects by first clicking the
object you want to move, and then moving it around the
canvas using the arrow buttons on your keyboard.
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4.3.2.2 Layers

Business Card Studio places each element on the canvas into its own layer with respect to the other
elements on the canvas. You can drag layers around the canvas or place them above or beneath other
layers. When one layer is dragged over another layer's position, by default it is placed on top that
layer.

You can change the properties of any or all layers on the canvas on the
Layers docking pane to the right of the card canvas. If the Layers tab
does not appear to the right of the canvas, you can open it by clicking
the green downward-facing arrow in the Layers section of the Home
menu tab. 

All the layers on the canvas are listed in the table in the center of the
dialog, with the selected layer highlighted in blue. You can select one of
the other layers by clicking its name in the table; the new layer's name
will then appear highlighted, and the corresponding element on the
canvas will be surrounded by a group of dots.

Learn More About:

Changing How a Layer is Displayed

Preventing or Allowing Changes to a Layer

Adding, Removing or Rearranging Layers

Selecting Layers to Be Grouped

4.3.2.3 Advanced Tools

The Advanced Tools pane features, by default, Rotation, Horizontal and Vertical Flip, and Opacity
options. Other options become available according to what is selected on the business card canvas.

You can rotate the selected graphic element by rotating the Rotate control clockwise or
counterclockwise. 
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Rotation angles are oriented like a compass, with zero degrees as up/
north, 90 degrees as right/east, 180 degrees as down/south, and 270
degrees as left/west.

To flip the object horizontally, click the Horizontal Flip button (at the
left). To flip the object vertically, click the Vertical Flip button (at the
right). This is a good way to create a mirrored or reflective effect.

To control how much of the layer beneath (or the background) shows
through, slide the Opacity slider left or right to make the object more
transparent or opaque.

4.3.3 The Bottom Pane

The bottom pane is located beneath the card canvas. Its two tabs, Generated Ideas and My Cards,
display thumbnail images of cards either generated by the Business Card Studio card-creation wizard
or card projects in various stages of development.

Learn More About:

The Generated Ideas Tab

The My Cards Tab

4.3.3.1 Generated Ideas

The Generated Ideas tab, located in the bottom pane, displays the business card ideas you have
created with the Business Card Studio Generate Cards wizard.
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You can edit any of the cards displayed in this window by right-clicking its thumbnail and selecting 
Edit Card from the pop-up menu.

If you like a particular design enough to keep, right-click its thumbnail and select Add to My Cards to
display it in the My Cards window.

4.3.3.2 My Cards

The My Cards tab, located in the bottom pane, displays thumbnail images of your business card
projects. If differs from the Card Concept & Info tab in that it does not also offer an information
summary about your card, but it also allows you to view a number of different card concepts at once,
instead of a single card or variations of a single concept.

Select any of the thumbnails within the My Cards window to display its card on the work canvas. You
can edit any of the text, shapes, and graphic objects on the card.

You can add a card project to the My Cards window by right-clicking either a thumbnail from 
Generated Ideas window or the card on the canvas and selecting Add to My Cards from the pop-up
menu.
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5 Advanced Features

Business Card Studio includes professionally designed graphic objects and artwork that you can use
on your business card. All objects are royalty-free and can be changed any way to fit the look you
want. Learn more about using these objects and customizing them to make impressive business
cards. 

Learn More About:

Working with Graphics

Working with Text

Working with Shapes

Working with Taglines

Using Layers

Advanced Color Options

5.1 Working with Graphics

5.1.1 Adding Logo Designs to the Canvas

The Logo Designs can be found in a slide-out pane on the left of the business card canvas; simply
move your mouse pointer over this tab to slide it out. Once the pane is out, you can keep it open
permanently by clicking the pushpin icon at the top right of the pane. If the Logo Designs tab does not
appear to the left of the card canvas, you can add it by clicking the Logo Designs button found in the
Insert menu.

This will display the Logo Designs dialog in the upper portion of the left-slide out pane. Choose one of
the categories to display the logos associated with it in the lower half of the dialog.
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Click on one of the logos to select it; a border will appear around the selected object. Move your
mouse cursor over to the work canvas; it will change to a crosshair (+) with a small picture below and
to the right of it. Click on the canvas to add the logo. 

You can manipulate the logo by using the sizing and rotational handle dots that appear around the
object or by using the object manipulation tools in the Advanced Tools slide-out pane to the right of
the canvas that appears when an object on the canvas is selected. The Advanced Tools pane also
allows you to adjust the width and height of the selected item on the card canvas. You can change the
color of any selected logo design(s) by using one of the color options from the Color menu tab, and
you can add special effects to the way the logo design appears using the choices in the Effects menu
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tab.

5.1.2 Modifying Logo Designs on the Canvas

You can modify different characteristics of the logo designs or graphic objects on the canvas using
Business Card Studio's intuitive set of tools. Using these tools, you can easily modify the size,
position, and appearance of a design object, and easily add color, images, and effects to them. 

Changing Size, Position, and Appearance
Once you select an object on the canvas, the 
Advanced Tools slide-out pane on the right side
of the card canvas will display a selection of
editing options, as will the Home menu tab above
the canvas.

Adding Color and Images to Objects

To change the color of an object, click the 
Color menu tab and then choose a color
option by clicking the large Color button and
selecting the type of color fill you want.

Note: The Solid option will create a blended
look for any of the pre-colored graphic objects
included with Business Card Studio. 
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Adding Effects to Objects

You can add shadow, frame, blur, and emboss effects
to your selected object by clicking on the Effects menu
tab and then choosing the effect you want from the 
menu displayed when you click the large Effects button.

5.1.3 Adding Pictures to the Canvas

You can import any graphic, image, or picture located on your computer directly into  Business Card
Studio by using the Picture button found in the Graphics section of the Insert menu tab.

Once you click the Picture button, a browser window will open to Business Card Studio’s default
Imported Images folder. The first time you open this, the folder should be empty because you have not
yet imported any pictures, but this folder will keep a copy of any imported picture for future use so you
don’t have to browse for the picture more than once. 

Simply locate the picture you want to import using the browse dialog window and then click the Open
button once you have found and selected the picture.

Move your mouse cursor over to the work canvas; it will change to a crosshair (+) with a small picture
below and to the right of it. Click on the canvas to complete the import process and add the picture to
your canvas. You can then modify the picture using the methods described in the Logo Designs
section or the Modifying Logo Designs on the Canvas section.

5.2 Working with Text

5.2.1 Adding Text to the Canvas

You can add text to the card canvas with the Text options found in the Insert menu tab. The editing
tools available for each text option can be found in the Advanced Tools pane on the right side of the
logo canvas. The text on any of the logo templates can be one of six types:
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Simple Text 
Has no special appearance effects of its own, but its size, position, and color can still be changed by 
modifying the text.

Memo Text 
Like Simple Text, this style has no special effects other than its stackable appearance, which can be
achieved by decreasing the width of the text box. Its size, position, and color can still be changed by 
modifying the text.

Outline Text 
Outlines the center of the added text with a default red color that can be changed in the Advanced
Tools pane, along with its width. You can also adjust the character spacing.

Projective Text 
Can be expanded in any one or all directions to produce telescoping or three-dimensional (perspective)
effects. You can also add an outline effect and adjust the character spacing.

Circular Text 
Curves around an external point. Selected curved text can be curved either above or below that external
point using the Circle Angle slider found in the Advanced Tools pane on the right side of the work
canvas. You can also add an outline effect and adjust the character spacing.

Wavy Text 
Undulates like ocean waves. The horizontal and vertical amplitude, wavelength, and shift can be
adjusted using sliders found in the Advanced Tools pane on the right side of the work canvas. You
can also add an outline effect and adjust the character spacing.

To add text, simply type in your desired text in the Type your text box, select a text type, and then
click the Add New Text button. 

Move your cursor to the canvas; it will change to a crosshair (+) pattern with the letters "ab" below and
to the right. 

Click (or hold down) your left mouse button to add the text to the canvas. 
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5.2.2 Modifying Text on the Canvas

You can modify the text by using either the white sizing handle dots around the text or by using the
text manipulation tools that appear in the Advanced Tools slide-out pane on the right of the canvas
when the canvas text is selected.

You can change the color of any selected text by using one of the color options from the Color menu
tab, and you can add special effects to the way the text appears using the choices in the Effects
menu tab.

You can also edit text by double-clicking it. This will open a Text Edit dialog that you can use to
replace the selected text with something different. Click the X button above the Advanced Tools pane
or press the Enter key to apply any changes. 

To change the size of the text on the canvas, click the text you want to change. It will be surrounded
by a group of dots that are sizing handles; when you move your cursor over one of them, it will change
to a two-headed arrow, indicating the directions you can move the cursor to enlarge or shrink the text.
To enlarge your text, hold down the mouse button and drag the cursor away from the text's center; to
shrink your text, drag the cursor toward the text's center.

Projective text works differently from the other text options:
Dragging any of the white dots at the corners alters the shape of the text in the direction the dot is
dragged. To enlarge the text, place the cursor on the black line between the white dots, hold down the
left mouse button and move the cursor away from the text center. To shrink the text, move the cursor
toward the text's center.

When you move your cursor over the green dot, it will change to a pair of curved arrows. By holding
down your left mouse button and moving your mouse to the right, you can rotate the text clockwise; by
moving your mouse to the left, you can rotate it counterclockwise.

When you move your cursor over the text itself, it will change to a hand with the index finger extended.
By holding down your left mouse button, you can drag the text anywhere on the canvas when you
move your mouse in a corresponding direction.

5.3 Working with Shapes

5.3.1 Adding Shapes to the Canvas

The Shapes section of the Insert menu tab allows you to add geometric and custom-drawn shapes to
your business card canvas.
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The available shapes include Rectangle, Rounded (Rectangle), Line, Ellipse, Triangle, Pentagon,
Star, Trapezoid, Rhombus, and Custom (drawing tool). 

Choose one of the options to highlight it and then move your cursor to the canvas area. The cursor will
change to a crosshair (+) with an image under it. Move the cursor to the location where you wish to
place the graphic and click your left mouse button to place the initial default shape on the logo
canvas. 

You can manipulate the shape using the sizing and rotational handle dots that appear around the
object or by using the object manipulation tools that appear in the Advanced Tools slide-out pane to
the right of the canvas when a shape on the canvas is selected. You can also adjust the width and
height of the selected shape  in the Advanced Tools pane. 

You can change the color of any selected object(s) by using one of the color options from the Color
menu tab, and you can add special effects to the way the object appears using the choices in the
Effects menu tab.

5.3.2 Modifying Shapes on the Canvas

Business Card Studio gives you advanced options to modify the shapes and add color and effects to
make them visually appealing. 

Adjusting a Shape
To modify a shape on the canvas, click the shape you want to change. It will be surrounded by a group
of dots that are sizing handles; when you move your cursor over one of them, it will change to a two-
headed arrow, indicating the directions you can move the cursor to enlarge or shrink the shape. To
enlarge your shape, hold down the mouse button and drag the cursor away from the shape's center; to
shrink your shape, drag the cursor toward the shape’s center.

Two of the available shapes have their own manipulation controls:

Rounded (Rectangle): You can change how rounded the corners on a rounded rectangle appear by
using the Corner Width and Corner Height sliders:

Slide the sliders to the right to increase the rounding; slide them to the left to lessen it. Sliding either
slider far enough to the left will turn a rounded rectangle into a regular rectangle, while sliding either
slider far enough to the right will turn it into an ellipse.
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Line: You can change the thickness of a line by sliding the Line Width slider to the left to make the
line thinner or to the right to make it thicker. You can also change a line into a single-headed or two-
headed arrow by using the Arrow1 and Arrow2 dropdowns. 

Select the type of arrowhead from the drop-down and use the sliders beneath it to adjust its size. The 
Width slider determines how far apart the ends of the arrowhead are from each other, while the
Length slider determines how far the arrowhead ends are from the point. Setting both Length sliders
to half the length of the line will make it look like an oblong diamond.

You can rotate the selected shape by rotating the Rotate control clockwise or counterclockwise.
Rotation angles are oriented like a compass, with zero degrees as up/north, 90 degrees as right/east,
180 degrees as down/south, and 270 degrees as left/west.

You can manipulate the position of any shape by using the Alignment options available in the 
Alignment slide-out pane to the right of the canvas. The top nine choices will align two or more
selected shapes with each other.

You can manipulate the position of any selected shape by using the Advanced Alignment boxes at
the bottom of the Alignment section. 

You can also align a shape by first clicking on the shape(s) you want to move, and then moving it
around the canvas using the arrow buttons on your keyboard.

Adding Color to Shapes
When you add a shape to your canvas, the default color of the shape is always blue with a black
outline.

Shapes give you another option to change the color if you only want a solid option. After selecting a
shape or shapes on the card canvas, you can adjust the polygon outline or fill color using the options
available in the Advanced Tools slide-out pane to the right of the canvas. 

Polygon Fill: This set of options changes the color and opacity of the shape itself. To change the
shape's color, click the down arrow at the right of the Color dropdown and select it from the dialog that
appears. To change the opacity of the shape's color, slide the Opacity slider to the left to make the
shape's color more transparent or right to make it more opaque. 

To get rid of the shape's color entirely, uncheck the Polygon Fill checkbox.

Polygon Outline: This set of options changes the color and thickness of the outline (border)
surrounding the shape. To change the outline color, click the down arrow at the right of the Color
dropdown and select it from the dialog that appears. To change the thickness of the outline, slide the 
Width slider to the right to make the outline thicker or left to make it thinner. 

To get rid of the outline entirely, uncheck the Polygon Outline checkbox.

For other options in changing the color of a selected shape, click the Color menu tab and then choose
an option by pressing the large Color button. The Solid color option is the default for changing the
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color of selected shapes, and the easiest way to do so. The Solid option also includes the Polygon
Outline and Polygon Fill tools.

Adding Effects to Shapes
You can add shadow, frame, blur, and emboss effects to your selected shape(s) by clicking on the 
Effects menu tab, and then choosing the effect you want from the  menu that appears when you click
the large Effects button.

5.4 Working with Taglines

5.4.1 Adding Taglines to the Canvas

Business Card Studio includes creative taglines that let you add marketing catchphrases to your
business card as text that you can modify to meet your needs.

Taglines can be found in a slide-out pane on the left of the card canvas;
simply move your mouse pointer over this tab to slide it out. Once the
pane is out, you can keep it open permanently by clicking the pushpin
icon at the top right of the pane. If the Taglines tab does not appear to
the left of the logo canvas, you can add it by clicking the Taglines
button in the Insert menu tab.

This will display the available taglines in a scrollable list. Click on one of
the taglines to select it; this will highlight the tagline. Move your mouse
cursor over to the work canvas; it will change to a crosshair (+) with the
letters "ab" below and to the right. Click on the canvas to add the
tagline. 

The slogan will appear on the canvas as simple text (text without any
special appearance effects of its own) and can later be edited the same
as other simple text. 

These slogans and taglines are general examples that you can modify
to suit your needs. To avoid possible copyright and trademark
infringement, you will need to research your completed slogan and/or
tagline with the proper legal or government source.
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5.5 Using Layers

5.5.1 Adjusting Display Properties

You can adjust the display properties of the layer elements in your business card project from the 
Layers slide-out pane to the right of the business card canvas.

Adjusting Layer Opacity
You can change the opacity of the selected layer by moving the Opacity slider left or right to make the
layer more transparent or opaque. As you move the slider, the percentage in the Opacity column will
change to reflect how opaque the layer is.

Hiding Layers From View
To hide the display of a layer, click the eye in front of that layer's name. 

The eye will appear closed, and the corresponding element will disappear from the canvas display. To
restore the element to the display, click the icon again; the "X" will disappear, and the element will
reappear on the canvas.

To hide the display of all layers, click the eye at the top of the Layers dialog. All the eyes will show a
red "X," and all the layers will disappear from the canvas display. You can restore the display of
individual layers by clicking the eye in front of each of the name of the layer you wish to restore to the
display. To re-display all the layers, click the eye at the top of the dialog again, and all of the elements
will reappear.

This only hides the display of the elements; it does not delete any of them from your project.

5.5.2 Modifying Layers

To prevent changes to a layer, click the open padlock icon in front of that layer's name. The icon will
change to a locked padlock and the layer will be protected from resizing, manipulation, or deletion. To
again allow the layer to be changed, click the padlock, and it will revert to an unlocked padlock. Click
the corresponding layer on the canvas, and you will again be able to manipulate it.
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To prevent changes to all canvas elements, click the padlock icon at the top of the Layers dialog. All
the unlocked padlocks will change to locked padlocks, and you will be unable to change any of the
layers. You can unlock an individual layer by clicking the padlock in front of it; if the layer was not
previously selected, click it on the canvas to select it again to manipulate. To unlock all layers, click
the padlock at the top of the dialog again, and all the layers will be unlocked.

5.5.3 Editing Layers

To add another layer of the same element type to the canvas, click the plus (  )  sign at the
bottom of the Layers dialog. 

To delete the selected layer, click the minus sign (  ).

To change the position of the selected layer with respect to the other
layers, 

click the Up (  ) or Down (  ) arrows at the bottom of the Layers
dialog to move the selected layer up or down in the list. If the layers are
positioned over one another on the canvas, the Up arrow will place the
layer on top of the layers listed beneath it, and the Down arrow will place
the layer below those listed above it.

5.5.4 Grouping Layers

To group two or more layers into a single unit, check the box in front of each layer on  the Layers
dialog that you want to include in the group. 
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The Group button (  ) on the Home menu tab will become active; click it to group the layers
together. The grouped layers will be encased by a single set of white sizing dots.

To group all the layers together, check the box in the upper left corner of the dialog. All the check
boxes below will become checked; now click the Group button on the Home menu tab.

To ungroup the layers again, click the Ungroup button (  ) on the Home menu tab. Each layer
will once again have its own sizing dots.

5.6 Advanced Color Options

5.6.1 Accessing the Advanced Color Palettes

You can access the color palettes by clicking the green arrow in the lower right hand corner of the
toolbar under the Color menu and clicking the specific palette in the left pane of the Color Palettes
window.
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5.6.2 Spectroscope Palette

The Spectroscope palette has four tabbed pages: Color, Saturation, Brightness, and Custom Palette.
Click the tab for the page you want to work with. You can also display a standard Windows color
palette.
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The Color Page
The Color page displays a color spectrum. Move your cursor over the spectrum; it will change to an
eyedropper. Click anywhere within the spectrum to select a color; it will be displayed in the field in the
upper right corner. The fields in the right center section will display the Red, Green, and Blue color
values; the Hue, Saturation, and Lightness values; and the hexadecimal value for the color.

The Saturation Page
To fine-control the saturation for your color, click the Saturation tab. The display will change to show
the color you selected on the Color page; drag your cursor up to increase the saturation and down to
decrease it.

The Brightness Page
To fine-tune the brightness/lightness of your color, click the Brightness tab. The display will change to
show a gradient of your selected color, growing progressively lighter (to the white) toward the top and
darker (to the black) and the bottom. Drag your cursor up to increase the brightness and down to
decrease it.

The Custom Palette Page
To choose a color from a graphic object, click the Custom Palette tab. To select a graphic, click your
right mouse button and select Open File from the popup menu that appears. An Open dialog will
appear, displaying Windows bitmap files and folders. When you find the file you want, highlight it and
click Open to display it on the Custom Palette page.

When you place your cursor over the bitmap, it will change to an eyedropper. Click your left mouse
button whenever you want to sample the color in the bitmap. The color at the cursor will appear in the
large square in the upper right corner of the page, and the Red, Green, Blue, Hue, Saturation, and
Lightness values will appear in the fields labeled with those letters.
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If you need to resize the bitmap within the palette, right-click again and select Zoom In from the popup
menu to bring the bitmap closer, Zoom Out to push it further away, or Original Size to display it at
its original size.

Displaying a Standard Color Palette
You can instead work with a standard Windows color palette by clicking the large square at the upper
right of the Spectroscope palette. Click one of the color squares under Basic colors, or drag the cursor
over the color palette on the right and click Add to custom colors to display the color under Custom
colors: and click the square the color appears in. Click OK to close the dialog and display the color on
the Spectroscope palette.

 

5.6.3 Color Charts Palette

The Color Charts palette has two tabbed pages: Basic and Metallic. Click the tab for the page you
want to work with.

Basic Tabbed Page

Metallic Tabbed Page
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Both pages feature a color grid. Drag your cursor over the grid; it will change to an eyedropper shape.
When your cursor is over a color within the grid, the bottom of the palette will display the color's
hexadecimal value, its RGB and HSV values, and the color name. Double-click when the cursor is over
the color you want to select.

5.6.4 HSV Palette

The HSV palette consists of the HSV Circle color wheel and two sets of slider controls: the HSV set
governs Hue, Saturation, and Value, while the RGB set governs Red, Green, and Blue color values.
You can adjust the color using either the wheel or the sliders.
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The color wheel will appear black if no layer is selected.

To adjust the color using the HSV Circle, drag the black line either clockwise or counterclockwise with
your cursor to change the hue. Drag your cursor toward or away from the center of the circle to adjust
the white saturation level circle; dragging toward the center decreases the saturation, while dragging
away from the center increases it.

To adjust the color using the sliders, drag a slider to the left to decrease its value and right to increase
it. The changes you make will be reflected in the color wheel. You can change the scaling method for
the cursors by clicking one of the radio buttons at the bottom of the palette.

The Color field at the top of the HSV palette graphically displays the color as you adjust it with the
wheel or sliders. When you are satisfied with the color, click Apply. Your selected text or object will
display in this color. If you wish to exit without applying the color, click the Cancel button. 

 

 



Business Card
Studio

Chapter

6



Business Card Studio66

© 2010 Summitsoft Corporation

6 Additional Preferences

You can set up additional preferences for your project by clicking the Preferences button located at
the bottom right corner of the File menu. The Preference Panel features options to set up the canvas
size, resolution, output type, and whether to display grids or dots as placement guides.
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Learn More About:

Setting up the Card Canvas

General Preferences

6.1 Canvas Setup

If, after starting your business card project, you find that you need a different card size or orientation to
work with or the background should be changed, you don't have to start over. You can use the Canvas
Setup options under the Preference Panel to adjust your Card Canvas, Canvas Output, and Grid. 
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Card Canvas
You can choose an appropriate card size: U.S. Horizontal Business Card, U.S. Vertical Business
Card, U.K. Horizontal Business Card, or U.K. Vertical Business Card. (U.S. business cards are
3.5 inches long and 2 inches wide, while U.K. business cards are 85 millimeters long and 55
millimeters wide, making them slighter shorter in length, but slightly wider than U.S. cards.) You can
also select Custom and specify the dimensions manually in pixels, inches, centimeters (cm), or
millimeters (mm). 

In addition to these preferences, you can also set up the layout and resolution of your card canvas. By
default, choosing either of the horizontal layouts automatically checks the Landscape check box and
selecting either of the vertical layouts unchecks it, but you can manually check or uncheck it to
reverse the card dimensions. (Landscape means that the horizontal dimension is longer than the
vertical, the way the painting of a landscape is typically arranged.)

Enter the resolution in dots per inch in the Resolution field. By default, this field displays a value of
"300," which is the typical resolution for printing. If you plan to create this card not to print but to
display on the Internet or send as a signature for an email, enter a value of "72." 

Canvas Output
The Canvas Output section lets you define the background of your card canvas. The default option is
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White, but you can select another color by selecting Background Color and choosing the color from
the dropdown, or select Transparent if you plan to use your card on the Internet and let your website
background be the card's background. 

You can also select Background Image to import a graphic to be your canvas. If you select this
option, enter the pathname to the graphic image you want to use as a background in the field beneath
the option, or click the Browse button to navigate to the image. Check the Tiled check box to repeat
the image as tiles across the canvas. 
 

Grid
Business Card Studio includes a non-printing reference grid for placing text, shapes, and objects that
you can turn on or off as you see fit by checking or unchecking Show Grid. You can set up the color
and size of the canvas grid with the Grid Size spin box and the Grid Color dropdown and force
objects to snap to the Grid by checking the Snap to Grid check box. If you prefer a grid of dots
instead of perpendicular lines, click the Show Dots check box. 

Click Ok to accept changes and exit, else click on the Cancel button.

6.2 General Preferences

Click the General button on the left pane of the Preference Panel to display the General section. This
section lets you set preferences for inserting objects and text, selecting multiple shapes, and when to
perform Hotzone scrolling. It also features a quick option to clear your projects from the My Projects
List. 
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You can choose to insert objects and text in the Insert and Texts section By Drag (of your mouse)
or By Click (of your left mouse button) based on your personal convenience. Similarly you can choose
in the Select multiple shapes by... section either Using [CTRL] + mouse drag or Starting a
mouse drag from an empty area to select multiple shapes. 

Additionally, you can set your Hotzone scrolling preferences from here. 

Once you have made changes, click Ok to apply them or click Cancel to exit without applying them. 
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7 Managing Your Business Card Projects

7.1 Importing an Image

Business Card Studio lets you import graphic images, according to the type of business card you are
creating. To import an image or graphic, click on the File menu (the round  "C holding a card" button at
the top left of the main program window) and click Import Image. You can then locate the image that
needs to be inserted and click Open.

Business Card Studio accepts graphic input in the following

formats:

Windows bitmap (*.bmp)

JPEG images (*.jpg, *.jp, *.jpeg)

HCK images (*.hck)

CompuServe GIF (*.gif)

Portable Network Graphics (*.png)

Windows Metafile (*.wmf, *.emf)
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7.2 Saving Your Card Project

To save your card project at any time, choose Save from the File menu (the round  "C holding a card"
button at the top left of the main program window) or click the shortcut Save button directly to the right
of the round File menu button. This saves the project file for any changes you might want to make in
the future, but cannot be used for any print or online use.

The Save dialog will be displayed. You can choose which project folder to save the logo file in from the 
Project Name dropdown list. The list of folders will include the names of the project folders in the My
Business Card Studio Projects folder created in your My Documents folder.  
 

If you are saving the business card for the first time, enter a name in the Card File Name field; if not,
your card name will appear in this field automatically. The Default Location checkbox is checked by
default; uncheck the box if you want to save the card in a different location than that specified in the
Location field.

Use the Preview Page dropdown to specify which page in the project is displayed on the canvas the
next time you open the business card project.

Click Ok to save the card, or Cancel to abort the save.

If you want to save your card under a different name or in a different location, choose Save As from the 
File menu. The Save dialog will appear and perform as described above. Click the Browse button to
navigate to a new location to save the file.

The default location for saving card projects is the My Business Card Studio Projects folder placed in
your My Documents folder when you save your first business card. Card projects are saved in a native
format with the extension *.bcg. This format can be read only by Business Card Studio and allows
you to fully modify your business card and retain all layers. This file needs to be kept in the project
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folder that was created when you saved your card project; if you move it out of this folder, you can
open the card project with Business Card Studio, but you will not be able to locate it in your recent
project files.

7.3 Printing a Proof Copy of Your Card

To print a proof copy of your card project at any time, choose Print from the File menu (the round  "C
holding a card" button at the top left of the main program window) and select Print... or click the
shortcut Print button directly to the right of the round File menu button. This prints a single copy of
your card on a full-sized sheet of paper so that you can manually proof it for errors, but cannot be used
to print the card for actual use. (To do this, see Printing Your Card to Cardstock.)

A standard Windows Print dialog will appear in which you can select your printer and the number of
copies to be printed.

7.4 Printing Your Card to Cardstock

To print your business card to cardstock, choose Print from the File menu (the round  "C holding a
card" button at the top left of the main program window) and select Print to pre-cut paper... from the
menu options. (If you first wish to print a single copy for proofreading, see Printing a Proof Copy of
Your Card.)

The Business Card Studio canvas will be replaced with a preview display of your card as it will display
on the cardstock option shown in the Cardstock dropdown list under Print Options. The list includes all
popular Avery cardstock selections. To the right of the list is a display showing the card type, height,
width, and page size. By default, the 3-card business card paper stock included in the retail boxed
version is selected.
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You can see the measurements for the card's side margin, top margin, horizontal and vertical pitch,
and height and width in dropdowns at the left of the Margins section. (The display below, which
defines those terms, appears to the right of the dropdowns.)

 

If none of the Avery card sizes meets your needs, you can specify a custom cardstock size by
clicking the Custom button. Enter the name for your custom card layout in the Label Name field and
define the margins, pitches, height, and width for your card. Choose the correct page size option for
your cardstock sheet from the Page Size dropdown list; if you choose the Custom option, use the
Page Width and Page Height spin boxes to specify the sheet size.

For your convenience, the preview display shows the cut marks for your cards. To hide this display,
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uncheck the Draw Cut Marks box in the Options section. (This will also prevent the cut marks from
being printed when you print your card.)

Click Print in the Actions section to print your card. Click Close to return to the work canvas display.

7.5 Printing Your Card as a PDF Document

To create a PDF (Portable Document Format) version of your business card, choose Print from the
File menu (the round  "C holding a card" button at the top left of the main program window) and select
PDF... from the menu options.

This will create a PDF document showing your card in the upper left corner. You can later print this
PDF or attach it to an email message.

You can also create a PDF by choosing Export from the File menu and selecting For Print Use...
from the menu options or clicking the Export button and selecting Print from the Select group format
screen, and then select PDF. This option offers additional controls for controlling the image quality
before creating the PDF.

7.6 Exporting Your Card Project

Cards created with Business Card Studio can be exported in a variety of formats for use online or in
print projects. To export your card, select one of the Export options (For Print Use..., For Online
Use..., Export a Grayscale Card) from the File menu (the round "C holding a card" button at the top
left of the main program window). 



Managing Your Business Card Projects 77

© 2010 Summitsoft Corporation

What will you use your business card for? 

(Advice on choosing a group format)

1. For Print Use…

Business Card Studio allows export of business cards in the BMP, PNG, TIFF, and PDF formats, but
you may also use other formats. The ideal export resolution for printed  cardsis 300 dpi, but the
software also supports export resolutions of up to 1200 dpi.

2. For Online Use…

Business Card Studio allows export of business cards for use on websites and other Internet
applications in the JPEG and PNG formats, but you may also use other formats. The recommended
export resolution for card images used on the Web is 72 dpi.

3. Export in Greyscale Format

Business Card Studio allows export of cards in an optimal greyscale format perfect for fax documents
or other lower-quality, non-color projects. The export resolution recommended for these projects is also
300 dpi.

Once you select a group format that suits your needs, click Next to choose your file format. You can
find more information on each file format in the Help file.
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To export for high-resolution printing, click the round File menu button at the top of the main program
window and choose Export > For Print Use…, and then choose JPEG, TIFF, or PNG. When you get
to the resize options window, make sure the Dpi value is set to 300. Click Next, and then choose
Browse to choose Desktop as your destination default location. Then hit Start Convert. You can now
see your exported business card on your desktop.

Some users mistakenly try to open and use the thumbnail that is generated when they save their card
(File > Save or File > Save As...). When you save your card, the program saves it in two formats: 1)
a file with a .bcg extension (this is your business card project that you can change or modify at a later
time), and 2) a file with a .png extension (this is a thumbnail picture of your card that is generated so
you can view your card projects in a preview browser window). These thumbnail image files are not
meant to be used in anything but the program. 

7.7 Sending Your Business Card

Business Card Studio lets you instantly email the business card design you just created to your
friends, associates, or any commercial printer. You can also save the card as an image format suitable
for sending as an attachment. This feature is recommended if you want to add the card as an
attachment to the email. 

To send the logo, click on the File menu button (the round "C holding a card" button at the top left of
the main program window) and click the Send button and select the Mail or Document option based
on your preference. 
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8 Product and Technical Support

8.1 Updating Business Card Studio

Summitsoft® periodically makes online program updates available. To check to see if your version of 
Business Card Studio is current, open the program and select Check for Product Update from the
Help options found by clicking the green circle question mark in the shortcut menu. 

The program will connect to the Summitsoft website. If an update is available, follow the online
instructions to update your copy of Business Card Studio.

8.2 Related Products

Summitsoft Corporation offers a range of exciting products for designing professionals and enthusiasts.
These include:

Logo Design software 
Vector Illustration software 
Email marketing software 
Press Release & Distribution software 
Fonts for commercial and personal use 
System Utility software 
and more... 

Find out more about the complete list of products and get access to online resources by visiting the
Summitsoft website.

www.summitsoftcorp.com

8.3 Getting Support

Purchasing your Summitsoft program gives you free access to Summitsoft’s online technical support.
Many questions may be answered by checking our support center on our website.

Visit the Summitsoft Support Center:

http://www.summitsoftcorp.com/support/help-desk-center.html

http://www.summitsoftcorp.com
http://www.summitsoftcorp.com/
http://www.summitsoftcorp.com/support/help-desk-center.html


Business Card
Studio

Chapter

9



Legal Issues 83

© 2010 Summitsoft Corporation

9 Legal Issues

9.1 Learn From LegalZoom.com

Trademark Guide

Summitsoft Corporation has partnered with the premier online legal document resource, LegalZoom.
com, to provide its customers with valuable information on how to protect any marks created or used
with its software products.

LegalZoom was founded by attorneys who have worked at some of the most prestigious law firms in
the country and have used their expertise to simplify the law and make it accessible for everyone. 

LegalZoom has found that while many people have legal needs, most of them don’t want to spend the
time or the money (over $240 per hour) to see an attorney. 

LegalZoom was created to help you quickly and affordably create estate planning documents, start a
business, register a trademark and more -- from the convenience of your home or office.

You can also receive 10% off any service offered by LegalZoom.com by entering the following
coupon code during checkout:

summit

Click on the item for specific suggestions related to it.

Introduction
The LegalZoom Trademark Registration and Order Process
Establishing Trademark Rights
Searching for Conflicting Trademarks 
Legal Requirements
The Process of Obtaining a Trademark
Grounds For Refusal
Enforcement
Legal Information

 

Introduction

A trademark is anything that is used, or intended to be used, to identify the goods of one manufacturer
from the goods of others. It is a brand name. Trademarks are important business tools because they
allow companies to establish their product's reputation without having to worry that an inferior product
will diminish their reputation or profit by deceiving the consumer. Trademarks include words, names,
symbols and logos. Anything that distinctly identifies your company can be a trademark, provided that
it is for goods. Although Summitsoft’s logo design software and other business-related products can
give you a creative jumpstart in designing an identity for your business, organization, product or service
name, it is still necessary to protect this identity legally using the appropriate lawyer or legal service. 

A service mark is very similar to a trademark, except that it is used to distinguish services in the
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stream of commerce. Like a trademark, a service mark can include words, names, symbols and logos.
Typically, trademarks appear on the actual product or its packaging, while service marks appear
mostly in advertising for the services. In this law library, when we use the term "trademark," we
generally mean both trademarks and service marks. 

If you wish to register your trademark or service mark, the online legal services of LegalZoom can help
you obtain a trademark from the convenience of your home or office, at your own time, and without any
hassles. Simply answer a few questions online and LegalZoom will take care of the rest, at a cost
considerably lower than what most lawyers would charge.

 

The LegalZoom Trademark Registration and Order Process

The following details describe the entire Trademark registration process for LegalZoom.com,
Summitsoft’s online legal partner site: 

1. Complete the LegalZoom online questionnaire. Click the Trademarks box and then click the getting
started link.

2. If your trademark is a stylized design or logo, you will need to send an image of the mark. If your
trademark is currently being used in commerce, a specimen will be required showing the mark as it
is actually used. 

3. A trademark search will then be conducted and all findings will be presented to you. In the 
LegalZoom online questionnaire, you can choose how comprehensive you want the search to be. If
there is a conflict with another trademark applicant or owner, you can elect to modify your
application, proceed as planned or cancel your application. 

4. Next, your trademark registration is prepared with the information you provide and the completed
application is then sent to you by e-mail for electronic signature. 

5. After you sign the application, LegalZoom will file it, along with the supporting material, with the
United States Patent and Trademark Office (the "PTO"). The PTO will assign a serial number to your
registration. 

6. About four months after filing, the PTO will review the application and determine whether the mark
may be registered. If the examining attorney determines that the mark cannot be registered, the
examining attorney will issue a letter listing any grounds for refusal and any corrections required in
the application. The examining attorney may contact you directly by e-mail if only minor corrections
are required. You must respond to any objections within six months of the mailing date of the letter,
or the application will be abandoned. 

7. If there are no objections, or if you overcome all objections, the examining attorney will approve the
mark for publication in the Official Gazette. The PTO will send a NOTICE OF PUBLICATION to you
indicating the date of publication. In the case of two or more applications for similar marks, the PTO
will publish the application with the earliest effective filing date first. Because of this, it is extremely
important you can show “first use” of your name or mark which must include an established date.
For example, if you upload your logo design to the FTP location of your online website, there is
usually a time stamp included with your upload that can help establish when your logo design was
first used. You can also establish an audit trail by publishing and printing your logo design, name or
mark on a newsletter, advertisement or product packaging that can show the manufactured or
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printed date from a purchase order you received from the manufacturer. Without proof of “first use,”
you will end up losing your trademark to the other applicant.

8. Receive Registration Certificate 

If the application was based upon the actual use of the mark in commerce prior to approval
for publication, the PTO will register the mark and issue a registration certificate about 12
weeks after the date the mark was published, if no opposition was filed. 

If, instead, the mark was published based upon the applicant's statement of having a bona
fide intention to use the mark in commerce, the PTO will issue a NOTICE OF ALLOWANCE
about 12 weeks after the date the mark was published, again provided no opposition was
filed. The applicant then has six months from the date of the NOTICE OF ALLOWANCE to
either (1) use the mark in commerce and submit a STATEMENT OF USE, or (2) request a
six-month EXTENSION OF TIME TO FILE A STATEMENT OF USE. If the STATEMENT OF
USE is filed and approved, the PTO will then issue the registration certificate. 

 

Establishing Trademark Rights

The Trademark rights of your logo design, name or brand identity are established by either (1) actually
using the mark (as on your business card or stationery), or (2) filing a proper application to register a
mark in the Patent and Trademark Office (PTO). Registering with the PTO is not necessary for
establishing trademark rights. However, registration of your mark can help secure benefits such as
giving everyone notice of your claim to the mark, having evidence of ownership of the mark, being able
to invoke federal court jurisdiction, being able to use the registration as a basis for obtaining
registration in foreign countries and being able to prevent the importation of infringing foreign goods. 

There are two types of rights in a mark: the right to register and the right to use. Generally, the first
party who either uses a mark in commerce or files an application with the PTO has the ultimate right to
register. The right of use can be more difficult to determine, especially when two parties begin use of a
mark without knowledge of the other party and without registering the mark. In a case like this, only a
court can decide who has the right of use. It should be noted that federal registration provides a
significant advantage in a court proceeding if you find that someone is using your trademark.

As mentioned before, using a template-driven software like Business Card Studio makes establishing
your trademark extremely important, especially if you plan on marketing your identity or selling your
name on a national or international level. Since other users of Business Card Studio and related
Summitsoft products will also have access to the same templates, determining the type of business,
service or product and how it relates to similar marks is an important part of the Trademark process.
Anyone wanting to establish a claim on the look of a mark in commerce, based on a common
template from Summitsoft’s logo design and business card software, should contact a lawyer or legal
service like LegalZoom as soon as possible.

Searching for Conflicting Trademarks
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While it is not required that you search for conflicting trademarks, it can be a good idea to do so
anyway. Should there be any existing trademarks registered that conflict with yours, your application
will be denied, and your filing fees will not be refunded. Doing a little research ahead of time can save a
headache later.

Additionally, it should be noted that because trademarks can be created through common law by using
the mark, it is also advisable to search for common law trademarks. It is less important to conduct a
common law search, but if you wish to, you should start with phone books, industrial directories, state
trademark registers. 

You can search for registered trademarks at the USPTO's website: http://www.uspto.gov. 

LegalZoom also offers a range of trademark searches that can fit your needs, whether you need to
protect your logo design, brand or other identity establishing name.
 

 

Legal Requirements

There are four basic requirements for filing a trademark (or service mark) with the United States Patent
and Trademark Office. The first requirement is that the mark must be filed under the name of the actual
owner of the mark. The owner of the mark is the person who controls the nature and the quality of the
goods sold or the services rendered under the mark. The owner does not have to be an individual; the
owner can be a partnership, a corporation, or an association. If the owner is a corporation, then the
applicant's name is the name of the corporation. If you are a one-person operation or small business
using Summitsoft’s logo design and business card software to establish and promote your look, you
can also use a service like LegalZoom to get incorporated, get non-profit status, or become an LLC or
DBA. 

The second requirement is that the applicant specify what type of entity it is (individual, corporation,
etc). The applicant must fill in national citizenship, although being a U.S. citizen is not required. 

The third requirement is the application must be based on an actual use or on a real intention to use
the mark in business. For the application to be based on actual use, the applicant should indicate
what products he or she has actually placed the mark on and sold for business. A mark for services
will be considered "actual use" when it is used or displayed in the sale or advertising of services and
the services are actually rendered. This can be easily done when using Summitsoft's logo design and 
business card software by creating your name and mark and then displaying the mark(s) on your
website, newsletters, advertisements, packaging or any other marketable material, as well as
distributing business cards carrying your name and trademark to prospective clients.

When you are filing an intent-to-use application, it is sufficient that you make a statement in good faith
that you plan to use the mark in commerce. However, you will have to actually use the mark before it
can actually be registered. The USPTO will first issue the Notice of Allowance, which gives you six
months to either use the mark in commerce or file for an extension. Once the Statement of Use is
filed, the USPTO will issue the registration certificate. 

The final requirement is that you submit a drawing of the mark and a specimen of the mark when the
application is based on actual use. A specimen is a real-world example of how the mark is actually
used on the goods or in a service. Labels, tags, or containers for the goods are considered to be
acceptable specimens of use for a trademark, as is a business card. Business Card Studio makes it

http://www.uspto.gov
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easy to print an example of the mark in use by allowing you to export or print directly from the
software; this includes creating a PDF document that clearly shows your business card carrying your
logo design, name and/or other mark that can then be printed and sent in with the specimen.

For a service mark, specimens may be advertising such as magazine advertisements or brochures.
Actual specimens, rather than facsimiles, are preferred. However, if the actual specimens are bulky, or
larger than 8½" x 11", then the applicant must submit facsimiles, (e.g., photographs or good
photocopies) of the specimens. 

A drawing is a page that depicts the mark you seek to register. In an application based on actual use,
the drawing must show the mark as it is actually used, i.e., as shown by the specimens. In the case
of an application based on a real intention to use, the drawing must show the mark as the applicant
intends to use it. A drawing is necessary even when a specimen is submitted.

The Process of Obtaining a Trademark

The registration process generally takes six months from start to finish, although it can last longer if
legal issues arise during the process. After filing an application, the USPTO will assign your file a
serial number and mail you a receipt about two months after filing. An attorney for the USPTO will
examine the application and will publish the mark in the Official Gazette. Other parties will have thirty
days from the date of publication to object to the mark. Thereafter, the USPTO will either issue a
Certificate of Registration (if the application was based on actual use) or will issue a Notice of
Allowance (if the application was based on intended use).

Grounds For Refusal

The USPTO will refuse to register a mark if it does not function as a trademark or service mark. Not all
words, names, symbols or devices function as trademarks. For example, names which merely
describe the goods on which it is used cannot be registered. You cannot register the mark "keyboard,"
for example, for a computer keypad. To give your mark the best chance for consideration, make sure
to shy away from generalized terms or descriptions. Instead, try adding a specific detail or personal
twist. For example, “business card design” is too general to trademark, but “Kay’s Cards” may give
you a better chance of trademark registration.

Additionally, Section 2 of the Trademark Act contains several of the most common (though not the
only) grounds for refusing registration. The grounds for refusal under Section 2 may be summarized
as: 

1. The proposed mark consists of or comprises immoral, deceptive, or scandalous matter; 

2. The proposed mark may disparage or falsely suggest a connection with persons (living or dead),
institutions, beliefs, or national symbols, or bring them into contempt or disrepute; 

3. The proposed mark consists of or comprises the flag or coat of arms, or other insignia of the United
States, or of any State or municipality, or of any foreign nation; 
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4. The proposed mark consists of or comprises a name, portrait or signature identifying a particular
living individual, except by that individual's written consent; or the name, signature, or portrait of a
deceased President of the United States during the life of his widow, if any, except by the written
consent of the widow; 

5. The proposed mark so resembles a mark already registered in the Patent and Trademark Office
(PTO) that use of the mark on applicant's goods or services are likely to cause confusion, mistake,
or deception; 

6. The proposed mark is merely descriptive or deceptively misdescriptive of applicant's goods or
services; 

7. The proposed mark is primarily geographically descriptive or deceptively geographically
misdescriptive of applicant's goods or services; 

8. The proposed mark is primarily merely a surname; and 

9. Matter that, as a whole, is functional.

Enforcement

Once you have registered your trademark, you will have legal ownership of the trademark. Additionally,
you can have the U.S. Customs Service prevent the importation of goods that infringe on your
trademark rights. However, if a domestic company infringes on your trademark, it is probably best to
consult an attorney specializing in trademark law. The factual situation of your particular case will
determine the best way to resolve the dispute. This is a decision that an attorney can help you make. 

For a trademark registration to remain valid, an Affidavit of Use must be filed: (1) between the fifth and
sixth year following registration, and (2) within the year before the end of every ten-year period after the
date of registration. The registrant may file the affidavit within a grace period of six months after the end
of the sixth or tenth year, with payment of an additional fee. 

Assuming that an affidavit of use is timely filed, registrations granted PRIOR to November 16, 1989
have a 20-year term, and registrations granted on or after November 16, 1989 have a 10-year term. This
is also true for the renewal periods; renewals granted PRIOR to November 16, 1989 have a 20-year
term, and renewals granted on or after November 16, 1989 have a 10-year term. 

The registrant must file a renewal application within the year before the expiration date of a registration,
or within a grace period of six months after the expiration date, with payment of an additional fee.

Legal Information

LegalZoom.com, Inc. is a registered and bonded legal document assistant, #0104, Los Angeles
County. LegalZoom.com is not a law firm and is not a substitute for the advice of an attorney. 

The trademark information found herein and on Summitsoft’s website is generously provided by its
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partner, LegalZoom.com. You can visit the LegalZoom website to learn more about the services they
provide to protect your trademark, help start and protect your business, or provide other legal services
you may find you need. 

Receive 10% off any service offered by LegalZoom.com; use the following coupon code
during checkout:

summit

Visit the LegalZoom website

9.2 Software License Agreement

READ THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT CAREFULLY BEFORE
INSTALLING THIS SOFTWARE.  

1. Grant of License- This is a legal contract between you and Summitsoft Corporation.  The terms of
this Agreement govern your use of this program.  By installing this software, you are agreeing to be
bound by this Agreement.  If you do not agree to the terms of this Agreement, please immediately
erase the software from your computer memory.  In consideration for your payment of the license fee,
which is your purchase price of the software, Summitsoft Corporation grants to you a non-exclusive,
non-transferable, limited license to use and display the software contained on this CD-ROM on a single
computer.  You may not copy it and give the copy to others to use or own, or use on a network. 
Summitsoft Corporation retains ownership and title to the software.  This Agreement is not a sale of
the original program or any copy.  The software is licensed only to you and may not be transferred,
assigned, rented, leased, sold or otherwise disposed of to anyone else.

2. Restrictions- The software is protected by both United States copyright law and international treaty
provisions.  Unauthorized copying of the software is expressly forbidden.  You may not distribute
copies of this software to others.  You may not modify, adapt, translate, reverse engineer, decompile,
disassemble, or create derivative works based on the software.  You may be held legally responsible
for any copyright infringement that is caused or incurred by your failure to abide by the terms of this
Agreement.  Subject to these restrictions, you may make as many copies of the software as you need
for archival use; for the sole purpose of backing up the software and protecting your investment from
loss, as long as the archival copy contains the same proprietary notices as appear in the original copy
of the software.

3. Termination- This Agreement is effective until terminated.  This Agreement (including the above
license) will terminate automatically, without notice from Summitsoft Corporation, if you fail to comply
with any provisions of this Agreement.  Upon termination you must destroy all copies of the software.

4. Limited Warranty/Remedy- Summitsoft Corporation warrants that the CD-Roms on which the
software is furnished shall, for a period of thirty (30) days from delivery (the “Warranty Period”) be free,
in normal use, from defects in material and workmanship.  Summitsoft Corporation will have no
responsibility to replace any CD-Roms that have been damaged by accident, abuse, or misapplication.
 If, during the Warranty Period, a defect in the CD-Roms appears, you may return the CD-Roms to
Summitsoft Corporation for repair, replacement or, if so elected by Summitsoft Corporation, refund of
your purchase price.  THE FOREGOING CONSTITUTES YOUR SOLE AND EXCLUSIVE REMEDY
UNDER THIS AGREEMENT.  Summitsoft Corporation does not warrant the completeness or accuracy
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of any information contained in the software, nor that the use of the software will meet your needs, nor
that its use will be uninterrupted or error free.  EXCEPT FOR THE WARRANTY SET FORTH ABOVE,
THE PRODUCT IS LICENSED “AS IS,” AND SUMMITSOFT CORPORATION DISCLAIMS ANY AND
ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION ANY
IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE
AND NON-INFRINGEMENT.  No Summitsoft Corporation dealer, distributor, agent or employee is
authorized to make any modification or addition to the foregoing warranty.  Some states do not allow
the exclusion of implied warranties or limitations on how long an implied warranty may last, so the
above limitations and exclusions may not apply to you.  This warranty gives you the specific legal
rights, and you may also have other rights, which vary from state to state.  

5. Limitation of Liability- Under no circumstances shall Summitsoft Corporation be liable to you on
account of any claim (whether based upon principles of contract, warranty, negligence or other tort,
breach of any statutory duty, principles of indemnity, the failure of any limited remedy to achieve its
essential purpose, or otherwise) for any special consequential, incidental, or exemplary damages,
including but not limited to lost profits, or for any damages or sums paid by you to third parties, even if
Summitsoft Corporation has been advised of the possibility of such damages.

6. Governing Law- This Agreement shall be governed by and construed in accordance with the laws of
the State of Nebraska. You consent to the exclusive jurisdiction of the state and federal courts located
in Omaha, Douglas County, Nebraska, United States of America for any and all disputes related to this
Agreement.
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Exporting Your Card Project     76

eye     57

eye-catching look     81

eye-catching print projects     81

eyedropper     60

- F -
F1 key     12

FAQs     81

fax documents     76

federal courts     89

File menu     8, 16, 27, 66, 72, 76, 78

File menu Save button     73

Fill method     30

fill options     30

fine-control the saturation     60

first business card     15

first card     15

flip     44

formats     8, 72

Frame     32, 50, 54

free downloads     9

Frequently Asked Questions     81

functions     27, 42

- G -
General Preferences     69

Generated Ideas     45

geometric shapes     53

getting help with your problem     81

Getting Started     11

Getting Support     81

Governing Law     89

Gradient     30

gradient direction     30

gradient pattern     30

Gradient sample field     30

Grant of License     89

graphic     29, 30, 53

graphic images     72

graphic input     72

graphic object     20

graphic objects     48

grayscale     76

grayscale format     8

green arrow     59

green circle question mark     81

green dot     53

Grid     67

Grid options     67

group     58

Group button     58

group layers into a single unit     58

group of dots     44

grouped     44

grouped layers     58

Grouping Layers     58

- H -
hard copy for proofreading     74

Hard Disk     11

hard-disk space     11

Hardware     11

HCK images     72

height     16

Height box     43

Height slider     32

Help     12, 27, 81
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help file topics     12

Help options     12, 81

hexadecimal color code     60

high quality TrueType fonts     81

high-resolution printing     76

Home     28

Home menu     29, 44, 50

Home menu tab     23, 29

horizontal     44, 51

Horizontal Flip     44

Horizontal Flip button     44

Horizontal Position slider     32

Hotzone scrolling     69

how rounded the corners are     54

How to Use This Help File     12

HSV Circle     63

HSV Palette     63

Hue, Saturation, and Value     63

Hue, Saturation, Lightness     30

- I -
icon     27, 57

image format     8, 72, 76

Image option     67

images     50

imagination     8

import     27, 72

import an image or graphic     72

import any graphic     51

Import Image     72

import logos     8

import process     51

Imported Images     51

imported picture     51

Importing     72

Importing an Image     72

inches     16

individual layers     57

Info     41

Info tab     26

Insert     11, 28, 51

Insert by Click     29

Insert menu     29, 48

Insert Objects     69

inserting objects by click     69

inserting objects by drag     69

inserting preferences     69

install     11

installation     11

installation program     11

Installing     11

interface     8, 26, 28

Internet applications     76

intuitive     39

intuitive set of tools     50

- J -
JPEG     72, 76

JPEG images     72, 76

- K -
keyboard     12, 29, 43

- L -
Landscape     67

Landscape checkbox     67

larger canvas     67

latest product updates     9

laws of the State of Nebraska     89

layer     44, 58, 63

Layer is displayed     44

Layers     43, 44, 57

Layers dialog     57, 58

Layers tab     44

learn more     12

Left and Top boxes     43

left and top edges     43

left slide-out pane     39, 42, 48

legal contract     89

Length slider     54

Length sliders     54

letterhead     35

License     89

License Agreement     89

lightness     30

Lightness slider     30

Limitation of Liability     89

limited license     89

limited remedy     89

Limited Warranty/Remedy     89

line     53
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Line adjustment options     54

Line Width slider     54

locked padlock     57

locked padlocks     57

locking layers     57

Logo Design Studio     81

logos     81

- M -
main program window     16, 20

main toolbar     12, 26, 27

main window     26

making a PDF     76

making shape color more transparent     54

manipulate canvas elements     57

manipulate the object     48, 50

manipulate the shape     53, 54

match business cards     35

material and workmanship     89

Memo Text     51

Memory     11

menu icon     27

menu name     27

Menubar     16, 28, 29

Menubar Options     26, 27

menus     8, 28

Metallic Color Chart     62

Metallic tab     62

millimeters     16

Minimum requirements     11

Minimum system requirements     11

mirrored effect     44

misapplication     89

modify a pre-designed template     20

modify a shape     54

modify the picture     51

modify the shapes     54

Modifying Layers     57

modifying object size and position     50

Modifying Objects     50

Modifying Objects on the Canvas     50

Modifying Shapes     54

Modifying Shapes on the Canvas     54

Modifying Text     53

More About Taglines     56

mouse button     53

mouse cursor     48, 51

move the cursor     53

My Business Card Studio Projects     16, 73

My Cards     46

My Documents folder     73

My Projects     23

My Projects List     69

- N -
Name and Brand Generator     81

navigate     16, 30

new card     16

New Card button     23

New Concept Canvas     26

new layer, creating     29

New Project     16

non-color projects     76

normal use     89

- O -
object     28, 30, 40, 43, 44, 48

Object Category     40

object placement     16

Objects     8, 30, 39, 40, 43, 48, 50, 51, 53

Objects button     48

Objects dialog     48

Objects tab     48

Omaha, Douglas County, Nebraska, United States of
America     89

online business card formats     76

online technical support     81

on-screen installation instructions     11

opacity     32, 54, 57

Opacity options     44

Opacity slider     32, 44, 54, 57

open a recent card project file     15

Open button     51

Operating System     11

oriented horizontally     67

outline effect     51

Outline Text     51

Outlines     51

- P -
padlock icon     57
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page icons     12

palette     30, 62

pane     48

partially transparent objects     32

Paste     29

pattern of color     30

PC     11

PDF     76

pdf document     8

PDF version of your business card     76

pentagon     53

percentage     57

perspective     51

picture     30, 51

Picture button     51

pixels     16

plus sign     58

PNG     76

Polygon Fill     54

Polygon Outline     54

Portable Network Graphics     72

position     43

position of the cursor     28

pre-colored     50

pre-colored graphic     50

pre-colored objects     30

pre-designed template     15

pre-designed templates     8

preference     66, 67

Preference Panel     66, 67

Preferences     27, 34, 66

Preferences button     66

preferences for inserting objects and text     69

PressRelease     81

preventing changes to a layer     57

Preview     27

preview browser window     76

Preview Page     73

Preview squares, gradient     30

Previous and Next buttons     12

principles of indemnity     89

print     8, 27, 35

printed business card formats     76

Printing a Proof Copy of Your Card     74

printing on cardstock     74

Printing Your Card as a PDF Document     76

Printing Your Card to Cardstock     74

produce telescoping text     51

product releases     9

professional logos     81

program     8, 76

program updates     81

program window     16

program wizard     21

project     57, 73

Project components     39

project file     23, 73

project folder     16, 23, 73

project folders     73

Project Name dropdown list     73

Project Name field     16

Projective Text     51, 53

proof copy     74

proprietary notices     89

protected layers     57

protecting layers from deletion     57

pushpin icon     39, 48

- Q -
Quick Tips     12

- R -
Radius slider     32

raised effect     32

rearranging layers     58

recent project files     23, 73

recommended export resolution     76

rectangle     53

rectangle appearance     54

red "X"     57

Red Green Blue     60

Red, Green, and Blue     63

Redo     29

reflective effect     44

refund     89

register online     9

Registering     9

Registration     9

Related Products     81

reliable designing experience     8

replacement     89

Resize Canvas     16, 34

resize the canvas     16, 34
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resize the canvas dimensions     16, 34

Resize, Duplicate     34

resolution     16, 67

restore the display     57

restore the object     32

Restrictions on use     89

return the CD-Roms     89

reverse engineer     89

revert     27

RGB and HSV values     62

RGB set     63

rhombus     53

right slide-out pane     43

Rotate control     44, 54

rotate selected graphic element     44

rotate text     53

rotating     44

Rotation     44

Rotation angles     44, 54

rotational handle dots     53

rounded rectangle     53

Rounded Rectangle adjustment options     54

royalty-free fonts     81

Run     11

- S -
saturation     30, 63

saturation level     30

Saturation tab     60

save     27, 73

Save As     73, 76

Save dialog     73

Saving Your Card Project     73

scaling method     63

scanner     8

select a shadow color     32

selected text or object     63

Selecting Layers     44

selecting multiple shapes     69

Send button     78

send the card     78

Sending Your Business Card     78

Setting Up Additional Preferences     66

Shadow     32, 50, 54

shadow blurrier     32

Shadow opacity     32

shadow sharper     32

shape     20, 29, 30, 53

Shapes     8, 23, 26, 29

shift     51

Show Dots grid option     67

shrink the text     53

shrink your text     53

simple text     51, 53, 56

sizing and rotational handle dots     48, 53

sizing dots     58

sizing handles     54

slide-out     39

slide-out pane     43, 48, 50, 56

slide-out panel     20, 28, 29

slide-out panels     27

Slide-Out Panes     39

slider     30, 32

slider controls     63

sliders     63

slogan     56

slogans and taglines     56

snap to grid     67

software is licensed     89

Software License Agreement     89

Solid Color     30

sophisticated color palettes     30

Spacing slider     32

special effects     32, 53

special offers     9

Spectroscope palette     59, 60

spectrum     60

Standard Color Palette     60

star     53

Start     11

Start Convert     76

Stationery Design Studio     81

Status Bar     26

Summitsoft     81

Summitsoft Corporation     8, 89

Summitsoft products     9, 81

Summitsoft website     81

Summitsoft’s online technical support     81

sums paid by you to third parties     89

System Requirements     11

- T -
tabbed interface     28

tabbed menus     28
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tabs     8, 28

tagline     42

Taglines     8, 23, 39, 42, 56

Taglines option     42

technical assistance     81

technical support     9, 81

template     20

template category     20

templates     8

Templates View     20

Terms and Conditions     89

terms of this Agreement     89

text     20, 23, 26, 29, 30, 51, 53

text options     8, 51, 53

The Bottom Pane     45

The Brightness Page     60

The Color Page     60

The Custom Palette Page     60

The Saturation Page     60

three-dimensional text     51

thumbnail     76

thumbnail business card images     45

thumbnails     45

TIFF     76

Tiled check box     67

tiles     67

tiling a background image     67

Toolbar Options     27

tools     8, 27

topics     12

trademark     8

translate     89

trapezoid     53

triangle     53

TrueType Fonts     81

two-headed arrow     53

Type your text box     51

- U -
Unauthorized copying     89

Undo     29

Undocked right slide-out pane     26

Ungroup     58

United States copyright law     89

unlock all layers     57

unlock an individual layer     57

unlocked     57

unlocked padlock     57

unlocked padlocks     57

Up arrow     58

update available     81

Updating Business Card Studio     81

use on a network     89

user interface     26

Using a Blank Canvas     16

Using a Template     20

using business cards on websites     76

Using Layers     48, 57

Using the Generate Cards Wizard     21

- V -
vertical     51

Vertical Flip     44

Vertical Flip button     44

Vertical Position slider     32

vertically     67

view your card projects     76

viewing card projects     45

viewing Generate Cards wizard results     45

viewing multiple card projects     46

visible menus     28

- W -
warranty     89

Warranty Period     89

wavelength     51

Wavy Text     51

website     8

welcome window     15, 16, 20

What Is Business Card Studio?     8

wheel     63

white dots     53

white sizing dots     58

width     16

Width box     43

Width slider     54

Windows bitmap     72

Windows® 2000     11

Windows® Vista     11

Windows® XP     11

wizard     21

work canvas     48, 51
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